Astronomy Visualisation Metadata Tagging Methods
By Amit Kapadia

Written by Amit Kapadia (akapadia@cfa.harvard.edu)
Approved by Lars Lindberg Christensen

Table of Contents
1 ASTRONOMY VISUALISATION METADATA ........................................................... 4
1.1 OVERVIEW .............................................................................................................. 4
1.2 DEFINITION OF AVM ................................................................................................. 5
1.3 SOFTWARE TOOLS ................................................................................................... 5
2 INSTALLATION .................................................................................................... 6
2.1 FITS LIBERATOR...................................................................................................... 6
2.1.1 AUTOMATIC INSTALLATION ..................................................................................... 6
2.2 ADOBE XMP PANELS ............................................................................................... 6
2.2.1 ADOBE CREATIVE SUITE 3 ...................................................................................... 7
2.2.2 ADOBE CREATIVE SUITE 4 ...................................................................................... 7
2.2.3 ADOBE CREATIVE SUITE 5 ...................................................................................... 8
2.3 PINPOINTWCS ........................................................................................................ 8
2.4 WORLDWIDE TELESCOPE ......................................................................................... 8
3 TAGGING TOOLS ................................................................................................ 9
3.1 ADOBE XMP PANELS ............................................................................................... 9
3.2 DJANGOPLICITY ..................................................................................................... 11
4 WORLD COORDINATE SYSTEM RECOVERY TOOLS .......................................... 12
4.1
4.2
4.3
4.4

ASTROMETRY.NET ................................................................................................. 12
PINPOINTWCS ...................................................................................................... 14
WORLDWIDE TELESCOPE ....................................................................................... 19
WCS RECALIBRATION DECISION TREE...................................................................... 22

5 TEST CASES ..................................................................................................... 24
5.1
5.2
5.3
5.4
5.5
5.6
5.7

METADATA TEMPLATES .......................................................................................... 24
TEST CASE 1: POTW1007A .................................................................................... 28
TEST CASE 2: ESO0928C ....................................................................................... 37
TEST CASE 3: ESO0925A ....................................................................................... 41
TEST CASE 4: POTW1009A ..................................................................................... 47
TEST CASE 5: ESO0911A ....................................................................................... 51
TEST CASE 7: M17_ISAAC_JHK ............................................................................. 59

2 | Astronomy Visualisation Metadata Tagging Methods

Table of Figures
Figure 3.1 The Adobe Bridge Interface ........................................................................................... 9
Figure 3.2 The XMP panel for editing AVM ................................................................................... 10
Figure 3.3 Djangoplicity CMS Interface ......................................................................................... 11
Figure 3.4 Creator metadata form in Djangoplicity ........................................................................ 11
Figure 4.1 Astrometry.net web-based form .................................................................................. 13
Figure 4.2 The PinpointWCS interface .......................................................................................... 14
Figure 4.3 PinpointWCS with data imported. In the left panel is a FITS image from DSS, in the right
panel is the EPO image. ............................................................................................................... 15
Figure 4.4 PinpointWCS highlighting corresponding features detected by the user ...................... 16
Figure 4.5 Matching frames using WCS ........................................................................................ 17
Figure 4.6 Locking crosshairs using WCS .................................................................................... 18
Figure 4.7 Checking the new WCS against the original FITS image .............................................. 18
Figure 4.8 WorldWide Telescope in Sky mode ............................................................................. 19
Figure 4.9 Enter approximate coordinates of the object in the upper right .................................... 20
Figure 4.10 Opening an EPO image in WWT ................................................................................ 20
Figure 4.11 Image Alignment mode in WWT ................................................................................. 21
Figure 4.12 WCS Retrofitting Decision Tree .................................................................................. 23
Figure 5.1 Adobe Bridge interface ................................................................................................ 25
Figure 5.2 Creating a metadata template ...................................................................................... 26
Figure 5.3 ESO contact metadata template .................................................................................. 27
Figure 5.4 ESA/Hubble contact metadata template ...................................................................... 28
Figure 5.5 Applying a metadata template ..................................................................................... 29
Figure 5.6 AVM Content fields ...................................................................................................... 30
Figure 5.7 AVM Observation fields ................................................................................................ 32
Figure 5.8 PinpointWCS interface ................................................................................................. 33
Figure 5.9 PinpointWCS with images loaded ................................................................................ 33
Figure 5.10 AVM Coordinates and Publisher fields ....................................................................... 34
Figure 5.11 Applying contact template ......................................................................................... 37
Figure 5.12 AVM Content fields .................................................................................................... 38
Figure 5.13 AVM Observation fields .............................................................................................. 39
Figure 5.14 AVM Content fields .................................................................................................... 41
Figure 5.15 AVM Observation fields .............................................................................................. 42
Figure 5.16 DSS Archive .............................................................................................................. 43
Figure 5.17 PinpointWCS with DSS data ...................................................................................... 44
Figure 5.18 Coordinates for M17 retrieved using PinpointWCS .................................................... 44
Figure 5.19 Content metadata for Potw1009a .............................................................................. 48
Figure 5.20 Observation metadata for Potw1009a ....................................................................... 49
Figure 5.21 WCS retrofitting of the EPO image using PinpointWCS .............................................. 49
Figure 5.22 Content metadata for eso0911a ................................................................................ 52
Figure 5.23 Observation metadata for eso0911a .......................................................................... 53
Figure 5.24 WCS retrofitting using DSS data ................................................................................ 54
Figure 5.25 Webpage of a successful Astrometry.net job ............................................................. 57
Figure 5.26 AVM coordinates from Astrometry.net ....................................................................... 58
Figure 5.27 PinpointWCS for M17 ................................................................................................ 59
Figure 5.28 Matching point sources in PinpointWCS .................................................................... 60
Figure 5.29 Testing the alignment of coordinates in DS9 .............................................................. 60
Figure 5.30 Transparent EPO image over WWT background sky. ................................................ 61
Figure 5.31 Opaque EPO image over WWT background sky........................................................ 61

Astronomy Visualisation Metadata Tagging Methods | 3

1 Astronomy Visualisation Metadata
1.1 Overview
The astronomical education and public outreach (EPO) community plays a vital role in conveying
the results of scientific research to the general public. A key product of EPO development is a
variety of non-scientific public image resources; both derived from scientific observations and
created as artistic visualisations of scientific results. This refers to general image formats such as
JPEG, TIFF, PNG, GIF, not scientific FITS datasets. Such resources are currently scattered across
the internet in a variety of galleries and archives, but are not searchable in any coherent or unified
way.
The primary focus of this document is on print-ready and screen ready astronomical imagery that
has been rendered from telescopic observations (also known as “pretty pictures”). Such images
can combine data acquired at different wavebands and from different observatories. While the
primary intent is to cover data-derived astronomical images, there are broader uses as well.
Specifically, the most general subset of this schema is also appropriate for describing artwork and
illustrations of astronomical subject matter.
The intended users of astronomical imagery cover a broad variety of fields: educators, students,
journalists, enthusiasts, and scientists. The core set of required tags defines the key elements
needed in a practical database for the identification of desired resources. For example, one might
choose to search for images of the Crab Nebula that include both infrared and visible light
elements, or for any images within two degrees of a specified location on the sky that include at
least some data from the Chandra X-ray Observatory.
The metadata used to characterize an image are only useful if they remain easily associated with
the image for all users. Once an image is separated from its source web page, any contextual
information is generally lost, including, most importantly, the original source of the image.
The AVM standard therefore encompasses not only the span of metadata tags, but an
implementation for embedding these tags directly within the image file itself. This keeps the
metadata available even for “loose” images.
The advantages of embedded image identity metadata are numerous. Including metadata
effectively makes the images self-documenting, which is particularly useful when the source URL
for an image is lost. This information can now be accessed by multimedia management packages,
or indexed by databases designed to read the embedded information. For instance, an online or
desktop planetarium program could load an image from the web and extract the appropriate
metadata to place it in the proper position in the sky.
Many observatories have adopted the AVM standard for outreach images, including the Spitzer
Science Center (SSC) and the Chandra X-ray Center (CXC). In 2009 the SSC launched an AVMdriven website1. The CXC is tagging all images with AVM, and migrating to an AVM-driven website.
ESO and ESA/Hubble is in the process of tagging the images and their web system is AVM driven,
and will soon be able to dynamically update the AVM info in the tiff files from a web interface. Third
party software such as Microsoft’s Worldwide Telescope and Google Sky have adopted the
standard, lending a new perspective to outreach products through a digital sky. The AVM standard
is widely adopted among EPO teams.

1

http://spitzer.caltech.edu
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1.2 Definition of AVM
The Adobe Extensible Metadata Platform (XMP) specification describes a widely used method for
embedding descriptive metadata within images. XMP tags are stored within the image header of all
common image formats (JPEG, TIFF, PNG, GIF, PSD) and can be read by popular image
processing and cataloging packages. The XMP standard is also widely used by photographers
and the publication industry. Users of consumer and professional digital cameras may already be
familiar with Exchangeable Image File Format (EXIF) metadata tags that include camera and
exposure information within the digital photo file as a set of XMP tags. In practice an XMP header
is a block of XML text included in the header block of the image file and is only supported in image
types with header/comment blocks.
Refer to the Astronomy Visualization Metadata (AVM) Standard for the Virtual Astronomy
Multimedia Project (VAMP) and other Virtual Observatories2 documentation for a detailed
description of the AVM standard.

1.3 Software Tools
There exist various methods to tag EPO images, each of which are discussed in this document.
They include:
1. FITS Liberator
2. Adobe XMP Panels (accessible through Adobe Photoshop and Adobe Bridge)
3. Djangoplicity (using Python-XMP-Toolkit and Python-AVM-Library)
To retrofit the EPO images with World Coordinate System information (the standard for writing
astronomical coordinates), there exist three commonly used tools:
4. Astrometry.net
5. PinpointWCS
6. WorldWide Telescope
This guide will first discuss the installation process of the most user-friendly tools listed above,
followed by instructions for tagging and retrofitting EPO images with WCS.

2

http://virtualastronomy.org/avm_metadata.php#2
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2 Installation
2.1 FITS Liberator
FITS Liberator is an Adobe Photoshop plug-in developed by the European Space Agency,
European Southern Observatory, and National Aeronautics and Space Administration. Its main
purpose is to expose the FITS file format to Photoshop for image processing, but it also allows
users to edit the metadata of the processed image. Currently FITS Liberator is only available for
versions of Photoshop up to CS4 although an update is planned for late 2010.
The ESA/ESO/NASA FITS Liberator is available from,

http://spacetelescope.org/projects/fits_liberator/

as a free download for Mac and Windows platforms.
There are two methods to install FITS Liberator, using the automatic installer or by a manual
installation. Since FITS Liberator is a Photoshop plug-in, Photoshop must already be installed to
use this software. Using the automatic installer is advised, unless a problem arises that may be
resolved via the manual installation process.
Refer to the download page of FITS Liberator for a detailed description of the installation process3.
2.1.1

Automatic Installation

2.1.1.1 Mac Installation
Installing FITS Liberator on a Mac consists of the following steps:
7. Open the disk image.
8. Double-click on the FITS Liberator Installer (FITS Liberator.mpkg) and follow the steps in the
installer. Note: Make sure to select the correct destination.
9. Double-click the Extras.mpkg file to install the File Info … panels and FITS Concatenator
script. You may have to select your preferred Photoshop installation folder depending on
the version you are running.
10. Eject and discard the disk image.

2.1.1.2 Windows Installation
The recommended way of installing the FITS Liberator on Windows is to use the setup program.
This will install all the necessary files and optionally register FITS files with Photoshop.

2.2 Adobe XMP Panels
The AVM standard is an extension of Adobe’s XMP standard. As a result there are tools that work
within Adobe products to add and modify AVM. These tools depend on the version of the user’s
Adobe product, each having a unique installation method.

3

http://spacetelescope.org/projects/fits_liberator/download_v23/
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There is an automatic installer contained within FITS Liberator, which installs the necessary files in
the correct directories.
For users that have not installed the extra package contained with FITS Liberator, or do not want
to install FITS Liberator, follow the manual instructions below, adhering to the correct version of
Adobe Creative Suite.
The necessary files may be downloaded from

http://spacetelescope.org/projects/fits_liberator/download_v23/.

This page contains links to download the panels for CS3 and CS4.
2.2.1

Adobe Creative Suite 3

When the user has downloaded the CS3 panels, there will be six text files, each representing a
different category of astronomy visualization metadata. For Windows, the files need to be copied to
the directory,
C:\Program Files\Common Files\Adobe\XMP\Custom File Info Panels,

for Mac the files need to be copied to,
/Library/Application Support/Adobe/XMP/Custom File Info Panels.

2.2.2

Adobe Creative Suite 4

Installing the CS4 panels requires slightly more effort than the CS3 panels. Upon extracting the files
from the download, the user will have a directory containing:
manifest.xml
bin/AstronomyVisualization.swf
loc/AstronomyVisualization_de_DE.dat
loc/AstronomyVisualization_en_US.dat
loc/AstronomyVisualization_fr_FR.dat
loc/AstronomyVisualization_jp_JP.dat

For a Windows machine all these files and directories need to be moved to,
{Program Files}\Common Files\Adobe\XMP\Custom File Info.

Additionally, the user should create a file named AstronomyVisualization.cfg in
{System}\Macromed\Flash\FlashPlayerTrust.

For 32-bit Windows {System} is usually
C:\Windows\System32

whereas for 64-bit Windows {System} is usually
C:\Windows\SysWOW64.

The file must contain the path to the location of the CS4 XMP panels, for example

Astronomy Visualisation Metadata Tagging Methods | 7

C:\Program Files\Common Files\Adobe\XMP\Custom File Info
Panels\2.0\panels\AstronomyVisualization.

For a Mac machine the files and directories need to be moved to,
/Library/Application Support/Adobe/XMP/Custom File Info Panels/2.0/panels/.

Additionally the user should place the trust file AstronomyVisualization.cfg in the directory,
/Library/Application Support/Macromedia/FlashPlayerTrust.

2.2.3

Adobe Creative Suite 5

The installation process for CS5 panels is similar to that of CS4. The only difference is the location
in which the files are copied.
Follow the instructions for CS4, but change the directory “2.0” to “3.0” in each path.

2.3 PinpointWCS
PinpointWCS is an easy-to-use application for retrofitting EPO images with World Coordinate
System (WCS) info. Currently it is only available for Intel-based Macs. To obtain the software visit
the software’s webpage at:

www.cfa.harvard.edu/~akapadia/pinpointwcs.

Here the user can download a disk image. After the file has downloaded, double-click the disk
image and drag the application to the “Applications” folder.

2.4 WorldWide Telescope
WorldWide Telescope (WWT) is a desktop planetarium package that is currently being developed
by Microsoft Research. It is aimed at both the general public and professional astronomers. There
are hidden tools available to outreach astronomers that assist in retrofitting EPO images with WCS
info.
To install the software a Windows machine is necessary. Visit

http://www.worldwidetelescope.org

to download the installer. Depending on the user’s computer, WWT may need additional packages
installed, namely Microsoft’s .NET 2.0 framework and the Windows Imaging Component. If these
are needed, the WWT installer will notify the user, and offer a link to the location of these
packages.
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3 Tagging Tools
This section guides the user through the steps involved in using some of the aforementioned tools
to tag and retrofit EPO images with WCS information. The most user-friendly tools are discussed.

3.1 Adobe XMP Panels
The Adobe XMP Panels provide a user-friendly way to tag EPO images with AVM. Many of the
tags are self explanatory, but some sections require information that is difficult to obtain for
archived images.
To begin tagging a single EPO image, open Adobe Bridge. The screen should appear as below.

Figure 3.1 The Adobe Bridge Interface

Select an EPO image by single-clicking it. Open the “File Info…” dialog by selecting the File -> File
Info... menu item. This will open a dialog allowing the user to edit XMP. With the AVM panels
installed, the user will also be able to edit AVM.
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Figure 3.2 The XMP panel for editing AVM

Selecting the “Astronomy” tab reveals all of the AVM fields. The user should complete this form
with as much information as possible. AVM is split into six distinct categories.
11. Creator metadata includes contact information to the observatory releasing the EPO
image. This information is general to all EPO images produced by the observatory.
12. Content metadata includes specific information about the context of the EPO image
release. Much of this information is generally available on the web page associated with
the image release.
13. Observation metadata include more technical information about the various observations
that were used to create the EPO image. This category includes information such as the
telescope and instrument that was used, as well as the colour mapping that was applied
to the generate the image.
14. Coordinate metadata refers to the World Coordinate System information that can correctly
locate the image on the sky. This information describes the location, dimensions, scale,
and rotation of the image when projected on to the sky.
15. Publisher metadata is a category reserved for a future central repository of EPO images.
Many of the fields in this section are not currently relevant.
16. FITS Liberator metadata contains the function and numerical values used to stretch and
scale the raw science data for EPO processing. The user should not worry to complete
these fields.
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3.2 Djangoplicity
An alternate method to tag EPO images is through the Djangoplicity web interface. This content
management system (CMS) is used for the ESO and ESA/Hubble websites and uses the PythonXMP-Toolkit and Python-AVM-Library to manipulate metadata. It allows the user to keep track of
every webpage and all media products. For the EPO images, the CMS contains a form with all
editable AVM fields.

Figure 3.3 Djangoplicity CMS Interface

The user may edit each field, as would be done using the Adobe XMP panels. Once the
information is saved, the metadata is updated in the website’s database and in the EPO image.

Figure 3.4 Creator metadata form in Djangoplicity
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4 World Coordinate System Recovery Tools
Education and public outreach images undergo various linear transformations during image
processing. These transformations, such as scaling, cropping, and rotating, invalidate the world
coordinate system information that is embedded with the FITS images. Since these
transformations are never recorded, it is necessary to re-compute the celestial coordinates for the
EPO image. This section describes three commonly used tools for this purpose. These tools may
be used independently, or in conjunction with each other.

4.1 Astrometry.net
Astrometry.net is software that computes WCS for astronomical images in tiff, jpg or FITS format
blindly. The use of the word “blind” means that this software is able to compute coordinates
without any reference input. The system is robust, allowing a wide variety of images to be correctly
matched against a database of stars. The result is accurate astrometry solved in an automated
manner. The Astrometry.net system uses the USNO-B star catalog, considered to contain
accurate astrometry to within 0.2 arc-second accuracy.
The web-based service is currently in alpha testing, and requires users to be granted access by
the developers. For access to the web-based version, follow the instructions on:

http://astrometry.net/use.html.

To use the web-based version, visit

http://live.astrometry.net/,

and fill in the form appropriately.
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Figure 4.1 Astrometry.net web-based form

The top two fields are specific to the user, email and name. When resolving EPO images, the user
may choose to upload the image, or supply a URL to the image. At this point, the user may submit
the image, but it is beneficial to supply additional information to speed the search process. In the
section titled “Scale of the image”, the user should enter an approximate scale. The scale of an
image refers to the length of sky that is represented by the image (i.e. the number of degrees that
span the image). Many telescopes have instruments that span only a tiny portion of the sky, so the
scale will be small. The webpage includes a tip stating, “Most digital-camera images are at least 10
degrees wide; most professional-grade telescopes are narrower than 2 degrees”. For many EPO
images, it is sufficient to approximate the scale of the image to be 2 degrees or less, depending on
the instrument used.
The service will usually take a few minutes when attempting to resolve an image, be patient.
Notifications are sent via email when the system begins and finishes the job.
NOTE: This method is the preferred tool when the EPO image has a large field of view ( > 7-8
arcminutes). When the field of view is too small, the image will not be able to resolve, and
Astrometry.net will fail to compute coordinates. This is a limitation of the star catalogs, rather than
the methodology used. There may be ways to improve the efficiency of the resolver but this cannot
be confirmed. Downsampling the images, noise-reduce them (to remove the faintest stars) or other
ideas could be tested.
For small fields of view the following tools may be more successful.
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4.2 PinpointWCS
An alternative to Astrometry.net is PinpointWCS. This software, however, requires the user to have
a FITS image with WCS in equatorial coordinates of the same region of sky, and preferably with
somewhat similar or higher resolution (note: this means that also similar archival observations can
be useful). The user matches corresponding features between the FITS image and EPO image.
With a minimum of three features matched, WCS is computed for the EPO image. For a more
accurate fit, it is beneficial to match more features, approximately 10 will offer a good fit.
Upon opening PinpointWCS the user will see the following window.

Figure 4.2 The PinpointWCS interface

To import data into the program, drag-and-drop the FITS file on the left panel, and the EPO image
on the right panel. Once both files have been dropped into the application, PinpointWCS will first
verify that the FITS image has appropriate WCS; it will then display a recommended scale of the
image.
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Figure 4.3 PinpointWCS with data imported. In the left panel is a FITS image from DSS, in the right panel is the EPO image.

World coordinate system information is displayed in the lower left corner. To the right are tools to
scale and stretch the FITS image for more optimal viewing. Various shortcut commands have been
implemented offering the user an easy way to manipulate the view of the image.
New
Workspace
Point Manager
Panning Image
Rotating Image
Zooming Image

Cmd + N
Cmd + P
Space Bar + Mouse
Drag
Cmd + R
Scroll Wheel via
Mouse

Next the user must match corresponding features between both images. A minimum of three
corresponding features is needed to retrofit EPO images with WCS info. More corresponding
features will result in a more precise pixel mapping from the FITS image to the EPO image. After
each additional correspondence, PinpointWCS will update its calculations.
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Figure 4.4 PinpointWCS highlighting corresponding features detected by the user

Notice in Figure 4.4 that new coordinates have been computed for the EPO image. After the user
is finished matching features, the new data must be exported. There are currently two options:
exporting the information as a FITS image and embedding the WCS via AVM.
In order to quality check the WCS solution, it is encouraged that the user exports in both options.
The output FITS image can be compared to the original FITS image using the FITS viewing
program, DS9.
This program may be obtained from,

http://hea-www.harvard.edu/RD/ds9/.

To compare the original FITS image with the output from PinpointWCS, open both images in DS9.
DS9 displays each image in the same window, each within its own frame. Next choose the menu
item “Frame -> Match Frames -> WCS”.
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Figure 4.5 Matching frames using WCS

This function will align both images using the WCS in the FITS header. Next choose the menu item
“Frame -> Lock Crosshairs -> WCS”. Then change the cursor to the crosshairs by choosing “Edit > Crosshair”.
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Figure 4.6 Locking crosshairs using WCS

Figure 4.7 Checking the new WCS against the original FITS image

The user may now check that corresponding features are aligned. Though PinpointWCS is helpful
for retrofitting EPO images with WCS information, it should be noted that the WCS is only as
accurate as the FITS image used. If the FITS image contains mis-aligned WCS, then the computed
WCS will also be mis-aligned. Additionally, due to inherent limitations, the computed WCS will be
projected in the gnomonic (tangent) projection; hence for images with a large field of view,
distortion will become largely apparent for pixels far from the reference pixel.
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4.3 WorldWide Telescope
WorldWide Telescope (WWT) may be used to align EPO images. The developers of WWT have
introduced tools to facilitate retrofitting EPO images with WCS information.
Documentation may be found at:

http://www.worldwidetelescope.org/docs/WorldWideTelescopeDataToolsGuide.html#ImageAlignmentwithin
WorldWideTelescope

To begin retrofitting, launch WWT. Ensure that WWT is in “Sky” mode. This may be changed using
the drop-down menu located in the bottom left.

Figure 4.8 WorldWide Telescope in Sky mode

Locate approximate coordinates for the object in the EPO image. Enter approximate right
ascension and declination, as shown in Figure 4.9.
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Figure 4.9 Enter approximate coordinates of the object in the upper right

With the sky position on the correct object, open the EPO image by using the menu item “Explore
-> Open -> Image…”

Figure 4.10 Opening an EPO image in WWT

Upon selecting an image to import, the user may be prompted with a message stating that no
coordinates were found in the image. Once the image has loaded, the user may adjust the position
by entering “Image Alignment” mode, activated by pressing Ctrl + E.
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Figure 4.11 Image Alignment mode in WWT

Using a combination of panning, rotating, and scaling, the user can adjust the position of the EPO
image against the background images in WWT. With the image aligned, the coordinates must be
saved to the WTML format. Right-click on the image thumbnail and choose “Add to Collection”.
The user may add it to an existing collection, or to a new collection. If a new collection is created,
the coordinates will be easier to locate in the WTML file. If the coordinates are added to an existing
collection, the user must take care not to confuse the new coordinates with coordinates from
another image in the collection.
With the coordinates computed, the metadata must be transferred from the WTML file to AVM; this
is done in Adobe Bridge. WWT does not use the AVM field names in the WTML format, so the user
must use the mapping below when transferring the information to AVM.
AVM Fields
Spatial.CoordinateFrame
Spatial.Equinox
Spatial.ReferenceValue
Spatial.ReferenceDimension
Spatial.ReferencePixel
Spatial.Scale
Spatial.Rotation
Spatial.CoordsystemProjection
Spatial.Quality

WTML Fields
ICRS
2000.0
CenterX; CenterY
Must be filled from image information
OffsetX; OffsetY
-BaseDegreesPerTile; BaseDegreesPerTile
-Rotation
TAN
Full

After the metadata is transferred, the process is complete. The EPO image has been retrofitted
with WCS information, with the new coordinates stored in the AVM format.
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4.4 WCS Recalibration Decision Tree
With three options to recalibrate EPO images, it is not immediately clear which method is the most
effective. Each EPO image will have its own optimal tool. The best workflow to adopt will be
determined by the user, but this section offers guidance.
If the image has a sufficiently large field of view (FOV), then begin with Astrometry.net. This tool has
an extremely high success rate when solving images with a FOV of at least 8 arcminutes. Images
of a smaller scale will take longer to process, and may not resolve.
The FOV of the image depends on the instrument that was used to collect the data.

Table 1 Range of FOV for ESO and Hubble Instruments

Instrument
AMBER4
EMMI
FORS1 & FORS25
HAWK-I6
ISAAC7
NACO8
PC2
SOFI9
VISTA10
Hubble/all instruments

Range of FOV
60 mas to 250 mas
4.25 arcmin x 4.25 arcmin to
6.8 arcmin x 6.8 arcmin
7.5 arcmin x 7.5 arcmin
1.2 arcmin to 2.5 arcmin
0.23 arcmin to 0.93 arcmin
< 4.92 arcmin
Up to 99 arcmin
Up to 2 arcmin

Preferred WCS Resolver
PinpointWCS/WWT
PinpointWCS/WWT
Astrometry.net/PinpointWCS/WWT
Astrometry.net
PinpointWCS/WWT
PinpointWCS/WWT
PinpointWCS/WWT
PinpointWCS/WWT
Astrometry.net
PinpointWCS/WWT

It is near certain that Hubble observations will not resolve through Astrometry.net, unless it is a
large mosaic. For these images, it is best to begin with PinpointWCS or WWT.
Below is a decision tree that assists the user in choosing the most optimal tool.

4

http://www.eso.org/sci/facilities/paranal/instruments/amber/inst/
http://www.eso.org/sci/facilities/paranal/instruments/fors/overview.html
6
http://www.eso.org/sci/facilities/paranal/instruments/hawki/index.html
7
http://www.eso.org/sci/facilities/paranal/instruments/isaac/inst/isaac_img.html
8
http://www.eso.org/sci/facilities/paranal/instruments/naco/overview.html
9
http://www.eso.org/sci/facilities/lasilla/instruments/sofi/
10
http://www.eso.org/public/teles-instr/surveytelescopes/vista/index.html
5
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Figure 4.12 WCS Retrofitting Decision Tree
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5 Test Cases
The rest of this guide will follow a test case of tagging multiple EPO images derived from various
observatories and instruments. The instruction provides a realistic perspective of the caveats that
are inherent to the tagging process. The images in this test case were derived from ESO
observatories and Hubble Space Telescope observations. Each image is tagged as complete as
possible, and re-calibrated with WCS information.
The following example images are described:
Image name

Telesc
ope

Instrument

Appro
x. Field
of
View
0.48
arcmin
utes

URL to tag image in
Djangoplicity

WCS
resolve
d?

WCS
Resolver

Other problems

potw1007a

HST

ACS/HRC

https://www.spacetelesc
ope.org/admin/media/im
age/potw1007a/

Yes

Pinpoint
WCS

AMBER

-

http://www.eso.org/publi
c/djangoplicity/admin/me
dia/image/eso0928c/

No

-

WCS is not very
accurate due to the
lack of features in
the image.
Only one filter
available. No
coordinates
calculated.

eso0928c

VLTI

eso0925a

NTT

EMMI

Pinpoint
WCS

VLT

FORS1

Yes

Pinpoint
WCS

eso0911a

VLT

FORS2

Yes

Pinpoint
WCS

ngc0157_H
AWKI

VLT

HAWK-I

http://www.eso.org/publi
c/djangoplicity/admin/me
dia/image/eso0925a/
https://www.spacetelesc
ope.org/admin/media/im
age/potw1009a/
http://www.eso.org/publi
c/djangoplicity/admin/me
dia/image/eso0911a/
-

Yes

potw1009a

Yes

Astromet
ry.net

Unreleased image,
no content metadata

m17_ISAAC
_jhk

VLT

ISSAC

8.6
arcmin
utes
6.74
arcmin
utes
5.63
arcmin
utes
7.2
arcmin
utes
8.8
arcmin
utes

-

Yes

Pinpoint
WCS

Did not resolve using
Astrometry.net.

5.1 Metadata Templates
Using Adobe Bridge, navigate to the directory containing the test case images.
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Figure 5.1 Adobe Bridge interface

This directory contains original FITS files and derived EPO images from several instruments
equipped on ESO observatories and the Hubble Space Telescope. Each set of images is
contained in its own directory.
The first objective is to tag all EPO images with “Creator” metadata. In this case, the ESO derived
images will use the following information,
Creator
Creator URL
Contact Address
Contact City
Contact State/Province
Contact Postalcode
Contact Country
Rights

European Southern Observatory
http://www.eso.org
Karl-Schwarzschild-Strasse 2
Garching bei München
Bavaria
D-85748
Germany
http://www.eso.org/public/outreach/copyright.html

while the HST images will use,
Creator
Creator URL
Contact Address
Contact City
Contact State/Province
Contact Postalcode
Contact Country
Rights

ESA/Hubble
http://www.spacetelescope.org
Karl-Schwarzschild-Strasse 2
Garching bei München
Bavaria
D-85748
Germany
http://www.spacetelescope.org/copyright/

The quickest way to apply general metadata to a large number of images is to use a metadata
template. Two templates will be created, one containing the contact information for ESO images,
the other containing the contact information for ESA/Hubble images.
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In Adobe Bridge, select “Tools->Create Metadata Template…” from the menu bar.

Figure 5.2 Creating a metadata template

This will open a dialog allowing users to create metadata templates. To create the template for
ESO images, set the Template Name to an appropriate title, for instance, “ESO Contact Info”. The
contact information that AVM uses is borrowed from the IPTC Core contact information. This
means that to create an AVM template with contact information, the user must use the IPTC Core
contact information.
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Figure 5.3 ESO contact metadata template

Notice that only the fields checked will be included in the template. Once the contact information
has been included, click “Save”. This template is now available to quickly tag images with contact
information.
The same is done for the ESA/Hubble images, with slightly different contact information.
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Figure 5.4 ESA/Hubble contact metadata template

With the metadata templates created, the test case images can be more easily tagged.

5.2 Test Case 1: Potw1007a
The first test case image is potw1007a. This is an EPO image derived from HST using the
Advanced Camera for Surveys (ACS) instrument’s High Resolution Channel (some of the highest
resolution and smallest images from HST). To begin tagging the image, select it, then open the
“File Info…” dialog in Adobe Bridge, and select the “Astronomy” tab.
On the bottom right of the dialog appears a drop-down menu that lists the metadata templates
created in the previous section. Since this is an ESA/Hubble image, the image requires the
ESA/Hubble contact information.
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Figure 5.5 Applying a metadata template

Just before applying the template, Bridge prompts the user to select the method in which to apply
the metadata. Choose the second method, “Keep original metadata, but replace matching
properties from template”. This choice ensures that any existing metadata is preserved, while
overwriting the contact information with metadata contained in the template.
Once the contact metadata has been completed, the user needs to complete the other AVM
fields, which are specific to the image. Much of the information in the “Content” category can be
obtained from the web page associated with the image release.
Searching on www.spacetelescope.org , the image release page is found to be:
http://www.spacetelescope.org/images/potw1007a/.
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Figure 5.6 AVM Content fields

The Title field is taken from the release title on the webpage.
The Headline field is meant to summarize the description in a few sentences;
it is generally okay to select the first few sentences from the description,
while also ensuring the headline is self-contained and coherent.
The Description field may be copied directly from the article on the webpage.
The Credit field is also copied directly from the webpage.
The Date field refers to the date in which the image was released. This
information is not readily available from the webpage.
The Subject.Name may be copied from the webpage; it is located in the
section titled “About the Object”.
The Subject.Category field is a numeric code specifying the type of
astronomical object. These codes are available in the appendix of this
document.
The Distance field can store up to two values, the first is a value with units of
light years, and the second has units of red shift. In this case, only the light
years unit is available in the description of the image. Often Simbad
(http://simbad.u-strasbg.fr/Simbad ) have reliable distance values.
The Distance.Notes is an optional field reserved for a more detailed
description of the Distance field. In this case, no additional information is
necessary.
The ReferenceURL field refers to the URL of the webpage containing this
information.
The ID field refers to the specifier used by ESA/Hubble to identify the image.

30 | Astronomy Visualisation Metadata Tagging Methods

The Spatial.Type refers to the type of image; in this case, the image was
derived from observations.
The Image.ProductQuality is a subjective field that measures the quality of the
image. Since the image has high-resolution, this field may be marked as
“Good”.
The next category is “Observation”. This category requires the user to hunt for more detail. Often
with archived images, the information needed to complete these fields may not be available.
Attempt to complete as many fields as possible.
In this case, much of the “Observation” information is found in the description of the object. The
image is composed of two observations from the HST using the ACS instrument. The two filters
are F658N and F625W, which are colored red and blue, respectively.

The Facility field composes of two facilities: “HST; HST”. Keep in mind that
many of these fields are multi-valued, with each value separated by a semicolon.
The Instrument field is “ACS; ACS”, since both observations come from the
ACS instrument.
The Spectral.ColorAssignment is “Red; Blue”. The first layer is colored red,
the second, blue.
The Spectral.Band is “Optical; Optical” since both observations are samples
from the optical wavelengths.
The Spectral.Bandpass is “H-alpha; R”. These are more specific
abbreviations associated with the wavelength captured by each
observation. In this case, these observations may be found from the ACS
documentation found at:
http://www.stsci.edu/hst/acs/documents/handbooks/cycle18/toc.html.
The Spectral.CentralWavelength are “658; 625”, and refer to the wavelength
that is in the middle of the observed spectral band. These values are
measured in nano-meters.
The Temporal.StartTime refers to the date or date-time in which the
observation was taken. This information can only be found in the FITS
header of the original data. Since this image is composed of two
observations, both FITS files are required to obtain the complete
information. Currently only one of the FITS files is available, the one
associated with the F625W image; only this portion of the data will be filled.
Using DS9, select “File->Display FITS Header…” and search for the FITS
keyword “DATE-OBS”. This field is filled with the following: “-; 2006-10-24”,
where the dash represents missing data.
The Temporal.IntegrationTime refers to the duration in which the observation
was conducted. This information is also located in the FITS header of each
observation. As in the case above, only one FITS file is available, so the data
will be partially completed. The associated FITS keyword is “EXPTIME”, in
this case, the field is filled with “-; 264.0”, measured in seconds.
The DatasetID field is completed using a unique identifier to each observation.
As in the above cases, only one observation is available. In this case, the
FITS keyword “ASN_ID” yields “J9QO01020” as the identifier.
The Spectral.Notes field is reserved for any additional notes that the user
wants to provide.

Astronomy Visualisation Metadata Tagging Methods | 31

Figure 5.7 AVM Observation fields

It is important to note the majority of these fields are multi-valued. In this case, there are two
elements for each field. If the image were composed of more layers, then there would be one
element for each layer, for each field.
To properly complete the next category, the image needs to be retrofitted with World Coordinate
System (WCS) information. These data are astronomical coordinates that describe the location,
scale, and rotation of the object in the celestial coordinate system. Since this is an HST image, the
preferred method is to use PinpointWCS.
To use PinpointWCS, the user must have access to a FITS image with WCS of the same field of
view as the EPO image. It is best to use a FITS image that was used to derive the EPO image, but
this is not strictly necessary.
Open PinpointWCS, and drag the FITS image on to the left panel, and the EPO image on to the
right panel.
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Figure 5.8 PinpointWCS interface

Once both images have been loaded, search both images for common features. When common
features are found, start by double-clicking on the feature in the FITS image, followed by doubleclicking the corresponding feature in the EPO image. This is place a marker over each image. This
must be done a minimum of 3 times in order for the new coordinates to be calculated.

Figure 5.9 PinpointWCS with images loaded

Once the WCS for the EPO image is calculated, it must be exported. There are currently two
options for export: as a FITS image, or via AVM. The FITS image option will export a FITS file that
may be opened in any FITS viewer, the AVM option will write the coordinates directly to the image.

Astronomy Visualisation Metadata Tagging Methods | 33

Export as AVM, and view the addition in Adobe Bridge.
The last section to complete is the Publisher category. Many of these fields are reserved for a
future service, thus, they cannot be completed at the present. The only fields that can be
completed are, MetadataDate and MetadataVersion. Mark the current date for the first, and
version 1.1 for the latter.

Figure 5.10 AVM Coordinates and Publisher fields

This completes the tagging of the first test case. Below is a table summarizing the metadata for
this case.
Creator

ESA/Hubble

CreatorURL

http://www.spacetelescope.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.spacetelescope.org/copyright/

Title

The Unique Red Rectangle: sharper than ever
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before
Headline

The star HD 44179 is surrounded by an
extraordinary structure known as the Red
Rectangle. It acquired its moniker because of its
shape and its apparent colour when seen in early
images from Earth. This strikingly detailed new
Hubble image reveals how, when seen from space,
the nebula, rather than being rectangular, is shaped
like an X with additional complex structures of
spaced lines of glowing gas, a little like the rungs of
a ladder.

Description

The star HD 44179 is surrounded by an
extraordinary structure known as the Red
Rectangle. It acquired its moniker because of its
shape and its apparent colour when seen in early
images from Earth. This strikingly detailed new
Hubble image reveals how, when seen from space,
the nebula, rather than being rectangular, is shaped
like an X with additional complex structures of
spaced lines of glowing gas, a little like the rungs of
a ladder. The star at the centre is similar to the Sun,
but at the end of its lifetime, pumping out gas and
other material to make the nebula, and giving it the
distinctive shape. It also appears that the star is a
close binary that is surrounded by a dense torus of
dust — both of which may help to explain the very
curious shape. Precisely how the central engine of
this remarkable and unique object spun the
gossamer threads of nebulosity remains mysterious.
It is likely that precessing jets of material played a
role.
The Red Rectangle is an unusual example of what is
known as a proto-planetary nebula. These are old
stars, on their way to becoming planetary nebulae.
Once the expulsion of mass is complete a very hot
white dwarf star will remain and its brilliant ultraviolet
radiation will cause the surrounding gas to glow. The
Red Rectangle is found about 2 300 light-years
away in the constellation Monoceros (the Unicorn).
The High Resolution Channel of the NASA/ESA
Hubble Space Telescope’s Advanced Camera for
Surveys captured this view of HD 44179 and the
surrounding Red Rectangle nebula — the sharpest
view so far. Red light from glowing Hydrogen was
captured through the F658N filter and coloured red.
Orange-red light over a wider range of wavelengths
through a F625W filter was coloured blue.
The field of view is about 25 by 20 arcseconds.
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Credit

ESA/Hubble and NASA

Subject.Name

HD 44179

Subject.Category

4.1.3

Distance

2300

ReferenceURL

http://www.spacetelescope.org/images/potw1007a/

ID

potw1007a

Type

Observation

Image.ProductQuality

Good

Facility

HST; HST

Instrument

ACS; ACS

Spectral.ColorAssignment

Red; Blue

Spectral.Band

Optical; Optical

Spectral.Bandpass

H-alpha; R

Spectral.CentralWavelength

658; 625

Temporal.StartTime

-; 2006-10-24

Temporal.IntegrationTime

-; 264.0

DatasetID

-; J9QO01020

Spatial.CoordinateFrame

ICRS

Spatial.Equinox

J2000

Spatial.ReferenceValue

94.9928800; -10.6374575

Spatial.ReferenceDimension

1154.0; 817.0

Spatial.ReferencePixel

578.0; 409.5

Spatial.Scale

6.93531e-06; 6.9353123e-06

Spatial.Rotation

-107.33

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

Spatial.Notes

WCS retrieved using CXCs PinpointWCS

Spatial.CDMatrix

1.9919444284e-06; 6.6205663668e-06;
6.6669905552e-06; -2.0655890032e-06

MetadataDate

6/30/2010
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MetadataVersion

1.1

5.3 Test Case 2: eso0928c
The next test case is an ESO image with ID eso0928c. Many of the steps for tagging this image
are identical to the first test case; however, there are some differences.
First the image needs to be tagged with contact information. Just as in the first test case, locate
the file in Adobe Bridge, open the metadata panels, and apply the “ESO Contact Info” template.

Figure 5.11 Applying contact template

Next, search www.eso.org to locate the webpage corresponding to the image. In this case the
webpage is located at: http://www.eso.org/public/images/eso0928c/. Much of the information
needed for the Content category is located on this webpage; however, additional information can
be found in the paper written by the principle investigator of these observations. That papers can
be found at: http://www.eso.org/public/archives/oldpdfs/HD87643_v4_1.pdf.
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Figure 5.12 AVM Content fields

Notice the Distance field is left blank. In the scientist’s paper it is stated that there are no precise
measurements for the object’s distance, only a rough estimate between 2–3 kpc.
The Observation category is filled using data from a single FITS files. Even though the EPO image
is derived from more than one observation, these other FITS images are not readily accessible. The
Observation category will be filled, though incomplete.

38 | Astronomy Visualisation Metadata Tagging Methods

Figure 5.13 AVM Observation fields

Since the FITS image does not contain much information, the image may only be tagged with the
information show in the image above.
Additionally, WCS retrofitting of this image is not possible since the FITS image does not contain
WCS information. One alternative is to use Astrometry.net, however the image does not resolve
with so few point sources. This is an example of an image that cannot be resolved using the
currently available EPO tools.
To complete the tagging of this image, the MetadataData and MetadataVersion need to be filled,
using the current date, and version “1.1”, respectively.
Below is a table summarizing the metadata.
Creator

European Southern Observatory

CreatorURL

http://www.eso.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.eso.org/public/outreach/copyright.html
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Title

The double star HD 87643

Headline

Observations made with ESO's Very Large
Telescope Interferometer allowed a team of
astronomers to discover that the star HD 87643,
which lies at the centre of a dusty nebula, has a
companion located about 50 times the mean
Earth-Sun distance.

Description

Observations made with ESO's Very Large
Telescope Interferometer allowed a team of
astronomers to discover that the star HD 87643,
which lies at the centre of a dusty nebula, has a
companion located about 50 times the mean
Earth-Sun distance. This companion completes an
orbit in a few tens of years and may be responsible
for the regular ejections of material that created the
nebula. By combining the light from various
combinations of three of the telescopes forming
the VLT array, the interferometric technique reveals
details 100 times smaller than shown with the
NACO adaptive optics instrument. The field of view
is only 100 milli-arcseconds, or less than one third
of a single WFI pixel.

Credit

ESO/F. Millour et al.

Date

8/5/2009

Subject.Name

HD 87643

Subject.Category

B.3.6.1

Distance.Notes

Distance unknown but estimated to be between 2
- 3 kpc.

ReferenceURL

http://www.eso.org/public/images/eso0928c/

ID

eso0928c

Type

Observation

Image.ProductQuality

Moderate

Facility

VLTI

Instrument

AMBER

Spectral.Band

Near-IR

Spectral.Bandpass

K

MetadataDate

6/30/2010

MetadataVersion

1.1
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5.4 Test Case 3: eso0925a
This test case differs from the previous two, in that the user has access to two FITS images. Much
like the process for the previous two cases, the user must apply the ESO contact information using
the metadata template, locate the webpage associated with eso0925a, and complete the Content
and Observation categories. The associated webpage is: http://www.eso.org/public/news/eso0925/.

Figure 5.14 AVM Content fields

In this case, there is no explicit credit listed, so it is offered to ESO. If this were an ESA/Hubble
image the credit would be attributed to ESA/Hubble. The Subject.Name field contains a variety of
names that refer to the object. Many of these names are stated in the description, while some are
taken from the HEIC webpage: http://www.spacetelescope.org/images/heic0305a/. It is important
to use other references to get a complete description of the object(s) in the image.
The Observation category is difficult for this case. Because of the richness in color, it is clear that
the image is derived from at least 3 observations (probably more), but the description does not
offer any information about the composition. Based on one of the FITS files, the Observation
metadata may be filled out as shown in the figure.
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Figure 5.15 AVM Observation fields

For the last category, Coordinates, the user is limited. The FITS images that are supplied do not
contain equatorial coordinates, so PinpointWCS will not able to compute a tangential mapping.
Submitting the image through Astrometry.net does not work either; the image fails to resolve.
Another alternative is to obtain another FITS image containing the same object, and which has an
equatorial projection. The DSS archive is the easiest database to search11.

11

http://archive.stsci.edu/cgi-bin/dss_form
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Figure 5.16 DSS Archive

Type the name of the object in the field titled “Object name”, and press “GET COORDINATES”;
SIMBAD is usually able to resolve the right ascension and declination. Next click “Retrieve Image”,
and a DSS image of the field of view will be downloaded. Be sure to rename the file, adding the
extension “.fits”, otherwise FITS viewers, such as PinpointWCS, may not be able to recognize the
file.
Using PinpointWCS, import the DSS and EPO images, and begin matching corresponding
features.
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Figure 5.17 PinpointWCS with DSS data

When a sufficient number of features have been matched, export via AVM. Upon checking in
Adobe Bridge, the new coordinates appear.

Figure 5.18 Coordinates for M17 retrieved using PinpointWCS

This case highlights the absence of observation data, and requires the user to search for an
appropriate FITS image to compute coordinates. These are standard procedures needed to
effectively tag an EPO image, and will be used frequently in practice.
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Just as done for the previous test cases, the MetadataDate and MetadataVersion fields need to be
completed.
Creator

European Southern Observatory

CreatorURL

http://www.eso.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.eso.org/public/outreach/copyright.html

Title

New portrait of Omega Nebula's glistening
watercolours

Headline

The Omega Nebula, a stellar nursery where infant
stars illuminate and sculpt a vast pastel fantasy of
dust and gas, is revealed in all its glory by a new
ESO image.

Description

The Omega Nebula, sometimes called the Swan
Nebula, is a dazzling stellar nursery located about
5500 light-years away towards the constellation of
Sagittarius (the Archer). An active star-forming
region of gas and dust about 15 light-years
across, the nebula has recently spawned a cluster
of massive, hot stars. The intense light and strong
winds from these hulking infants have carved
remarkable filigree structures in the gas and dust.
When seen through a small telescope the nebula
has a shape that reminds some observers of the
final letter of the Greek alphabet, omega, while
others see a swan with its distinctive long, curved
neck. Yet other nicknames for this evocative
cosmic landmark include the Horseshoe and the
Lobster Nebula.
Swiss astronomer Jean-Philippe Loys de
Chéseaux discovered the nebula around 1745.
The French comet hunter Charles Messier
independently rediscovered it about twenty years
later and included it as number 17 in his famous
catalogue. In a small telescope, the Omega
Nebula appears as an enigmatic ghostly bar of
light set against the star fields of the Milky Way.
Early observers were unsure whether this curiosity
was really a cloud of gas or a remote cluster of
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stars too faint to be resolved. In 1866, William
Huggins settled the debate when he confirmed the
Omega Nebula to be a cloud of glowing gas,
through the use of a new instrument, the
astronomical spectrograph.
In recent years, astronomers have discovered that
the Omega Nebula is one of the youngest and
most massive star-forming regions in the Milky
Way. Active star-birth started a few million years
ago and continues through today. The brightly
shining gas shown in this picture is just a blister
erupting from the side of a much larger dark cloud
of molecular gas. The dust that is so prominent in
this picture comes from the remains of massive
hot stars that have ended their brief lives and
ejected material back into space, as well as the
cosmic detritus from which future suns form.
The newly released image, obtained with the EMMI
instrument attached to the ESO 3.58-metre New
Technology Telescope (NTT) at La Silla, Chile,
shows the central region of the Omega Nebula in
exquisite detail. In 2000, another instrument on the
NTT, called SOFI, captured another striking image
of the nebula in the near-infrared, giving
astronomers a penetrating view through the
obscuring dust, and clearly showing many
previously hidden stars. The NASA/ESA Hubble
Space Telescope has also imaged small parts of
this nebula (heic0305a and heic0206d) in fine
detail.
At the left of the image a huge and strangely boxshaped cloud of dust covers the glowing gas. The
fascinating palette of subtle colour shades across
the image comes from the presence of different
gases (mostly hydrogen, but also oxygen, nitrogen
and sulphur) that are glowing under the fierce
ultraviolet light radiated by the hot young stars.
Credit

ESO

Date

7/7/2009

Subject.Name

Omega Nebula; Swan Nebula; The Horseshoe;
Lobster Nebula; M 17; Messier 17; NGC 6618

Subject.Category

B.4.1.2

Distance

5500

ReferenceURL

http://www.eso.org/public/news/eso0925/
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ID

eso0925

Type

Observation

Image.ProductQuality

Good

Facility

NTT

Instrument

EMMI

Spectral.Band

Optical

Spectral.Bandpass

R

Temporal.StartTime

2005-06-03

Temporal.IntegrationTime

4.9993

Spatial.CoordinateFrame

ICRS

Spatial.Equinox

J2000

Spatial.ReferenceValue

275.2033696; -16.1754990

Spatial.ReferenceDimension

3069.0; 3069.0

Spatial.ReferencePixel

1535.5; 1535.5

Spatial.Scale

4.66918e-05; 4.6691836e-05

Spatial.Rotation

-179.13

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

Spatial.Notes

WCS retrieved using CXCs PinpointWCS

Spatial.CDMatrix

4.6639618122e-05; 7.0622236416e-07;
9.2990557614e-07; -4.6686494901e-05

MetadataDate

6/30/2010

MetadataVersion

1.1

5.5 Test Case 4: potw1009a
This test case is an image from ESO’s VLT observatory using the FORS1 instrument. Two FITS
files are supplied. As is usual, search for the EPO image via the ESO website. The webpage is
found to be: http://www.eso.org/public/images/potw1009a/.
Using the information found on this page, the user may fill out the AVM fields.
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Figure 5.19 Content metadata for Potw1009a

Each of these fields is directly pulled from information on the webpage. The Subject.Category field
represents a barred galaxy.
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Figure 5.20 Observation metadata for Potw1009a

Based on the information on the webpage, the user may complete some fields from the
observation category. The Temporal.StartTime and Temporal.IntegrationTime are obtained for only
one image from one of the FITS files, using the FITS keywords “DATE-OBS” and “EXPTIME”,
respectively.
PinpointWCS is used to obtain the Coordinate metadata. This process is completed exactly as
done previously.

Figure 5.21 WCS retrofitting of the EPO image using PinpointWCS

Lastly, the MetadataDate and MetadataVersion need to be filled. This completes test case 4.
Creator

European Southern Observatory

CreatorURL

http://www.eso.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.eso.org/public/outreach/copyright.html

Title

Darth Vader’s Galaxy, NGC 936

Headline

Glowing in the cosmos at a distance of about 50
million light-years away, the galaxy NGC 936 bears
a striking resemblance to the Twin Ion Engine (TIE)
starfighters used by the evil Dark Lord Darth Vader
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and his crew in the epic motion picture Star Wars.
Description

Glowing in the cosmos at a distance of about 50
million light-years away, the galaxy NGC 936 bears
a striking resemblance to the Twin Ion Engine (TIE)
starfighters used by the evil Dark Lord Darth Vader
and his crew in the epic motion picture Star Wars.
The galaxy’s shiny bulge and a bar-like structure
crossing it bring to mind the central engine and
cockpit of the spacecraft; while a ring of stars
surrounding the galactic core completes the
parallel, corresponding to the wings of the TIE
fighters that are equipped with solar panels.
This galaxy harbours exclusively old stars and
shows no sign of any recent star formation. Bars
such as that observed in NGC 936 are common
features of galaxies; however, this one is
significantly more marked than average. Although
a perfect symbol for the dark side of the “Force”, it
is still debatable whether this galaxy is dominated,
like most others, by a large amount of dark matter.
This image has been obtained using the FORS
instrument mounted on one of the 8.2-metre
telescopes of ESO’s Very Large Telescope on top
of Cerro Paranal, Chile. It combines data acquired
through four wide-band filters (B, V, R, I). The field
of view is about 7 arcminutes.

Credit

ESO

Date

3/1/2010

Subject.Name

NGC 936

Subject.Category

C.5.1.2

Distance

50000000

ReferenceURL

http://www.eso.org/public/images/potw1009a/

ID

potw1009a

Type

Observation

Image.ProductQuality

Good

Facility

VLT; VLT; VLT; VLT

Instrument

FORS1; FORS1; FORS1; FORS1

Spectral.Band

Optical; Optical; Optical; Optical

Spectral.Bandpass

B; V; R; I

50 | Astronomy Visualisation Metadata Tagging Methods

Temporal.StartTime

2004-08-13; 2004-08-13; 2004-08-13; 2004-0813

Temporal.IntegrationTime

-; 389.98; -; -

Spatial.CoordinateFrame

ICRS

Spatial.Equinox

J2000

Spatial.ReferenceValue

36.9114872; -1.1573008

Spatial.ReferenceDimension

2018.0; 2018.0

Spatial.ReferencePixel

1010.0; 1010.0

Spatial.Scale

5.5625e-05; 5.5625026e-05

Spatial.Rotation

-0.03

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

Spatial.Notes

WCS retrieved using CXCs PinpointWCS

Spatial.CDMatrix

-5.5649232101e-05; 2.473281687e-08;
7.9653824471e-09; 5.5625020063e-05

MetadataDate

7/7/2010

MetadataVersion

1.1

5.6 Test Case 5: eso0911a
Just as the previous test cases, the process for eso0911a does not differ too much. One caveat to
point out refers to the Content metadata.
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Figure 5.22 Content metadata for eso0911a

Carefully reading the description on the webpage http://www.eso.org/public/news/eso0911/, the
user will notice that the image refers to two distinct objects. The most prominent object is Arp 261,
two colliding galaxies; the second object of interest is the supernova SN 1995N. To properly tag
this image, both objects need to be acknowledged in the metadata. This is apparent in the fields
Subject.Name and Subject.Category.
For the Observation metadata the user needs to use information located on the webpage:
http://www.eso.org/public/images/eso0911a/. This page contains information about the
composition of the image. It describes the telescope, instrument, wavelengths, and colors used to
create the EPO image.
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Figure 5.23 Observation metadata for eso0911a

To retrofit the EPO image with WCS info, the user may try Astrometry.net; however, the image fails
to resolve. Another option is PinpointWCS, but the FITS files supplied do not contain equatorial
coordinates, and cannot be used by the program. A third option is to retrieve another FITS image
from a service such as DSS.
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Figure 5.24 WCS retrofitting using DSS data

Using the DSS image, the user is able to re-calibrate the EPO image. This is a delicate process
when the EPO image is of a narrower field of view than the FITS image. The user should make sure
that each star is correctly aligned; otherwise, the coordinates will be calculated incorrectly.
Creator

European Southern Observatory

CreatorURL

http://www.eso.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.eso.org/public/outreach/copyright.html

Title

A Curious Pair of Galaxies

Headline

The ESO Very Large Telescope has taken the best
image ever of a strange and chaotic duo of
interwoven galaxies. The images also contain
some surprises — interlopers both far and near.

Description

Sometimes objects in the sky that appear strange,
or different from normal, have a story to tell and
prove scientifically very rewarding. This was the
idea behind Halton Arp’s catalogue of Peculiar
Galaxies that appeared in the 1960s. One of the
oddballs listed there is Arp 261, which has now
been imaged in more detail than ever before using
the FORS2 instrument on ESO’s Very Large
Telescope. The image proves to contain several
surprises.
Arp 261 lies about 70 million light-years distant in
the constellation of Libra, the Scales. Its chaotic
and very unusual structure is created by the
interaction of two galaxies that are engaged in a
slow motion, but highly disruptive close encounter.
Although individual stars are very unlikely to collide
in such an event, the huge clouds of gas and dust
certainly do crash into each other at high speed,
leading to the formation of bright new clusters of
very hot stars that are clearly seen in the picture.
The paths of the existing stars in the galaxies are
also dramatically disrupted, creating the faint swirls
extending to the upper left and lower right of the
image. Both interacting galaxies were probably
dwarfs not unlike the Magellanic Clouds orbiting
our own galaxy.
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The images used to create this picture were not
actually taken to study the interacting galaxies at
all, but to investigate the properties of the
inconspicuous object just to the right of the
brightest part of Arp 261 and close to the centre of
the image. This is an unusual exploding star, called
SN 1995N, that is thought to be the result of the
final collapse of a massive star at the end of its life,
a so-called core collapse supernova. SN 1995N is
unusual because it has faded very slowly — and
still shows clearly on this image more than seven
years after the explosion took place! It is also one
of the few supernovae to have been observed to
emit X-rays. It is thought that these unusual
characteristics are a result of the exploding star
being in a dense region of space so that the
material blasted out from the supernova ploughs
into it and creates X-rays.
Apart from the interacting galaxy and its supernova
the image also contains several other objects at
wildly different distances from us. Starting very
close to home, two small asteroids, in our Solar
System between the orbits of Mars and Jupiter,
happened to cross the images as they were being
taken and show up as the red-green-blue trails at
the left and top of the picture. The trails arise as
the objects are moving during the exposures and
also between the exposures through different
coloured filters. The asteroid at the top is number
14670 and the one to the left number 9735. They
are probably less than 5 km across. The reflected
sunlight from these small bodies takes about
fifteen minutes to get to the Earth.
The next closest object is probably the apparently
bright star at the bottom. It may look bright, but it
is still about one hundred times too faint to be
seen with the unaided eye. It is most likely a star
rather like the Sun and about 500 light-years from
us — 20 million times further away than the
asteroids. Arp 261 itself, and the supernova, are
about 140 000 times further away again than this
star, but still in what astronomers would regard as
our cosmic neighbourhood. Much more distant
still, perhaps some fifty to one hundred times
further away than Arp 261, lies the cluster of
galaxies visible on the right of the picture. There is
no doubt, however, that a much more remote
object lies, unrecognised, amongst the faint
background objects seen in this marvellous image.
Credit

ESO

Astronomy Visualisation Metadata Tagging Methods | 55

Date

3/16/2009

Subject.Name

Arp 261; SN 1995N

Subject.Category

C.5.1.7; C.3.1.8

Distance

70000000

ReferenceURL

http://www.eso.org/public/news/eso0911/

ID

eso0911a

Type

Observation

Image.ProductQuality

Good

Facility

VLT; VLT; VLT; VLT

Instrument

FORS2; FORS2; FORS2; FORS2

Spectral.ColorAssignment

Blue; Green; Red; Red

Spectral.Band

Optical; Optical; Optical; Optical

Spatial.CoordinateFrame

ICRS

Spatial.Equinox

J2000

Spatial.ReferenceValue

222.3750575; -10.1712461

Spatial.ReferenceDimension

1378.0; 1665.0

Spatial.ReferencePixel

690.0; 833.5

Spatial.Scale

6.81491e-05; 6.8149076e-05

Spatial.Rotation

-0.65

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

Spatial.Notes

WCS retrieved using CXCs PinpointWCS

Spatial.CDMatrix

-7.1307903502e-05; 7.7339197881e-07;
3.0295752549e-06; 6.8144687593e-05

MetadataDate

7/7/2010

MetadataVersion

1.1

As of this writing, this image has yet to be released. In this test case, the image will only be recalibrated with WCS. The image is composed of observations from ESO’s HAWK-I instrument on
the VLT. Referring to Table 1 the HAWK-I instrument has a field of view of approximately 7.5 x 7.5
arcminutes. This may be a sufficient size for Astrometry.net.
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Navigate to the online service at: http://live.astrometry.net/. Fill in the form with an email address,
name, and choose the image for upload. In the section titled “Scale of the image” set an between
upper bound 8 – 10 arcminutes. Submit the job, and wait patiently for Astrometry.net to recalibrate
the image.
If successful, Astrometry.net will supply a link to the job with the WCS information.

Figure 5.25 Webpage of a successful Astrometry.net job

These data need to be transferred over to AVM. This may be done by copying and pasting certain
values in the appropriate fields via Adobe Bridge. Below is a table showing the Astrometry.net
fields that correspond to AVM fields.
Table 2 Astrometry.net fields to AVM fields

Astrometry.net Fields

AVM Fields

(RA, Dec) center

Spatial.ReferenceValue

Pixel scale

Spatial.Scale

Orientation

Spatial.Rotation

The other AVM fields need to be completed by the user.
Table 3 Additional WCS information to complete

AVM Fields

Data

Spatial.CoordinateFrame

ICRS

Spatial.Equinox

2000.0

Spatial.ReferenceDimension

{pixel dimensions of the image}

Astronomy Visualisation Metadata Tagging Methods | 57

Spatial.ReferencePixel

{location of the center pixel}

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

Note: When applying Spatial.Scale, two values are necessary. It is important to add a negative sign
to the second value. This will solve a well-known reflection difference that exists between FITS and
other image formats.
The image below shows the values that have been entered to re-calibrate the EPO image.

Figure 5.26 AVM coordinates from Astrometry.net

Creator

European Southern Observatory

CreatorURL

http://www.eso.org

Contact.Address

Karl-Schwarzschild-Strasse 2

Contact.City

Garching bei München

Contact.StateProvince

Bavaria

Contact.PostalCode

D-85748

Contact.Country

Germany

Rights

http://www.eso.org/public/outreach/copyright.html

Spatial.CoordinateFrame

ICRS
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Spatial.Equinox

J2000

Spatial.ReferenceValue

8.69503953166; -8.39835317931

Spatial.ReferenceDimension

3951; 3929

Spatial.ReferencePixel

1975.5; 1964.5

Spatial.Scale

3.05555556E-5; -3.05555556E-5

Spatial.Rotation

179.76

Spatial.CoordsystemProjection

TAN

Spatial.Quality

Full

MetadataDate

7/28/2010

MetadataVersion

1.1

5.7 Test Case 7: m17_ISAAC_jhk
Beginning with this test case, only WCS retrieval will be discussed. ISAAC on the VLT has a very
narrow field of view as shown in Table 1. Astrometry.net will most likely not resolve this image, so
it is best to turn to PinpointWCS or WWT. Since a FITS file is readily available, WCS is computed
using PinpointWCS. These steps are just as previously explained. It is best to match
corresponding point sources in all areas of the image.

Figure 5.27 PinpointWCS for M17

When there are many point sources to choose from, it is best to use smaller features where the
center is not as ambiguous. Figure 5.28 shows a smaller feature being used despite the presence
of a larger star nearby.
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Figure 5.28 Matching point sources in PinpointWCS

When the WCS has been exported it may be tested in DS9. Just as explained previously, the
frames need to be aligned via WCS, as well as the cursor.

Figure 5.29 Testing the alignment of coordinates in DS9

The image may also be tested in a desktop planetarium program such as WWT.
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Figure 5.30 Transparent EPO image over WWT background sky.

Figure 5.31 Opaque EPO image over WWT background sky
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